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1
Overview
Dell SupportAssist collects information about your computer hardware and software, and automatically 
creates support cases when issues arise. This helps Dell to provide you an enhanced, personalized, and 
efficient support experience. Dell uses this data to help solve common problems and design and market 
the products and services features you use most.

SupportAssist integrates with Dell OpenManage Essentials to provide support capabilities for the 
following Dell enterprise server, storage, and networking solutions, using the existing environment data:

• Dell PowerEdge servers (9G to 12G)

• Dell PowerVault NX storage servers

• Dell PowerVault MD storage arrays

• Dell EqualLogic SAN devices (except PS5000)

• Dell EqualLogic devices with Fluid File System (FluidFS)

• Dell PowerConnect Ethernet switches

• Dell Force10 Ethernet switches

• Dell PowerEdge M1000e Blade Enclosure

• iDRAC7

• Dell PowerEdge VRTX

NOTE: For a complete list of supported operating systems and device models, see the Dell 
SupportAssist Version 1.3 Support Matrix at dell.com/ServiceabilityTools.

NOTE: SupportAssist does not support Dell PowerEdge C servers, Dell PowerVault NAS, Dell 
Compellent devices, Dell DR4000 , Dell PowerVault RD1000, and Brocade switches.

NOTE: SupportAssist provides limited support for PowerConnect stacked configurations.

SupportAssist also provides rich device, support case, and service contract reporting.

You can access information about the OpenManage Essentials-managed Dell devices and related support 
cases from the Device Inventory and Case List reports in the SupportAssist dashboard.

Equipping your OpenManage Essentials server with SupportAssist is voluntary, and results in improved 
support, products, and services designed to meet your needs.

Key Features

The key features of SupportAssist include:

• Remote monitoring — Monitors your hardware to inform you of critical alerts.

• Automated log and configuration collection — Information required for troubleshooting the issue is 
automatically collected and sent to Dell.

• Automatic support case creation — When a critical alert is received from your hardware by 
OpenManage Essentials, the alert information is sent to Dell and a service request is automatically 
created. A Dell technical support agent contacts you about the alert and helps you resolve the issue.
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NOTE: Support cases opened prior to SupportAssist installation, do not appear in the 
SupportAssist dashboard.

• Proactive parts dispatch — Based on examination of the troubleshooting data, if the Dell technical 
support agent determines that a part needs to be replaced in your environment, a replacement part is 
dispatched to you with your consent.

Features Supported With Dell Service Contracts

The features supported in your environment may vary based on your Dell service contract.

The following table provides a comparison of the features available with the Dell Basic Hardware and Dell 
ProSupport service contracts.

Feature Basic Hardware ProSupport ProSupport Plus

Remote monitoring

Automated log and configuration 
collection

Automatic support case creation

Proactive parts dispatch

Environmental intelligence 
reports

Case Data Handling

For increased performance, SupportAssist case data is cached prior to display in the dashboard, and is not 
displayed in real time. When launched, SupportAssist:

• Queries Dell once every three minutes for cases in the Submitted state to determine if it needs to 
update the case status.

• Determines the last time the case data was updated for a submitted case. It then queries the cases for 
which cached status information has expired in the last three minutes.

• Queries Dell once every 15 minutes for cases in all status other than Submitted.

NOTE: If the data for a particular case is older than 15 minutes by the next poll time, SupportAssist 
queries for that data in the current poll. Therefore, SupportAssist may only poll for cases that are in 
the Open state for case data every 12 minutes.

Event Handling

SupportAssist intelligently handles event storm conditions, allowing up to nine separate alerts from your 
OpenManage Essentials-managed environment in a 60-minute time span. However, if it receives 10 or 
more separate alerts it automatically enters Maintenance Mode. For information on Maintenance Mode, 
see Preferences and Setting SuppotAssist To Maintenance Mode.

Maintenance Mode suspends any further processing of alerts, enabling you to make infrastructure 
changes without generating unnecessary alerts. After 30 minutes in Maintenance Mode, SupportAssist 
automatically exits Maintenance Mode and resumes normal alert processing.
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Data Collected By SupportAssist

NOTE: By default, SupportAssist collects data from all supported devices in an environment, 
irrespective of the service contract type of the devices, and uploads the data to Dell. The collection 
of data is staggered, and the data is collected from 5 to 10 devices at a time. For information about 
the default frequency of data collection, see Default System Log Collection Schedule.

SupportAssist continually monitors the configuration data and usage information of OpenManage 
Essentials-managed Dell hardware and software. While Dell does not anticipate accessing or collecting 
personal information, such as your personal files, web-browsing history, or cookies, in connection with 
this program, any personal data inadvertently collected or viewed will be treated in accordance with the 
Dell Privacy Policy available for review at dell.com/privacy.

The information encrypted in the data log sent to Dell includes the following categories of data:

• Hardware and software inventory — Installed devices, processor(s), memory, network devices, usage, 
and Service Tag.

• Software configuration for servers — Operating system and installed applications.

• Network identity information – Computer name, domain name, and IP address.

• Event data — Windows event logs, core dump, and debug logs.

For more information about the collected troubleshooting information, see Accessing And Viewing The 
System Log Collection.

NOTE: If the security policy of the company restricts sending some of the collected data outside of 
the company network, you can configure SupportAssist to filter the collected data before sending it 
to Dell. For more information, see Filtering The System Log Collection.

NOTE: For more information about the data collected by SupportAssist and how the collected data 
is used by Dell, see the Dell SupportAssist: Security Considerations technical document at dell.com/
SupportAssistGroup.

What Is New In This Release

• Support for installing SupportAssist on a management server running:

– Microsoft Windows Server 2012 R2 Standard edition

– Windows Server 2012 Domain Controller

– Windows Server 2012 R2 Domain Controller

• Support for managed nodes running Windows Server 2012 R2 Standard edition.

• Support for a new installation workflow — The collection tools are downloaded and installed after the 
installation of SupportAssist.

• Support for the following Force10 devices:

– Ethernet switch: S50, S4820T, S5000, and S6000

– Ethernet switch/router: MXL, Z9000, and S4810

• Support for Dell EqualLogic FS7500 with Fluid File System (FluidFS) version 1 and 2; EqualLogic 
FS7600 with FluidFS version 2.

NOTE: Only alerts from EqualLogic SAN are supported.

• Support for automatically updating SupportAssist and the associated collection tools.
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2
Installing, Upgrading, And Uninstalling 
Dell SupportAssist
The following sections provide information about installing, upgrading, and uninstalling Dell 
SupportAssist.

Prerequisites

The following are the prerequisites:

• Dell PowerEdge servers running Dell OpenManage Essentials version 1.3

• Familiarity with OpenManage Essentials installation, configuration, and operation

For more information about installing, configuring, and using OpenManage Essentials, see the 
appropriate Dell OpenManage Essentials User’s Guide and Dell OpenManage Essentials Release Notes at 
dell.com/openmanagemanuals.

Minimum Requirements

This section provides the minimum requirements for SupportAssist to provide proactive support for Dell 
PowerEdge servers (9G to 12G), Dell EqualLogic and PowerVault MD arrays and storage solutions, 
EqualLogic FluidFS NAS appliances, iDRAC7, Dell PowerConnect Ethernet switches, Dell Force10 Ethernet 
switches, Dell PowerEdge M1000e Blade Enclosure, and Dell PowerEdge VRTX.

NOTE: For information about SNMP configuration, firewall settings, web services, supported ports 
and protocols specific to your environment, see the Dell SupportAssist Version 1.3 Quick Start Guide 
and the Dell OpenManage Essentials User’s Guide at dell.com/support/manuals.

Related Links

Software Requirements

Hardware Requirements

Network Requirements

Software Requirements

The following are the minimum required software configurations:

• Dell OpenManage Essentials 1.3.

• Optional: Dell OpenManage Server Administrator (OMSA) installed and operational on all managed 
PowerEdge devices.

• SNMP agent enabled on all managed PowerEdge servers, EqualLogic, EqualLogic FluidFS NAS, 
PowerVault, iDRAC7, CMC, Force10, PowerConnect, and PowerEdge VRTX devices for OpenManage 
Essentials discovery.

• All managed PowerEdge, EqualLogic, EqualLogic FluidFS NAS, PowerVault, iDRAC7, CMC, Force10, 
PowerConnect, and PowerEdge VRTX devices configured to send SNMP traps to the OpenManage 
Essentials server.
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• All managed PowerEdge, EqualLogic, EqualLogic FluidFS NAS, PowerVault, iDRAC7, CMC, Force10, 
PowerConnect, and PowerEdge VRTX devices discovered, categorized, and inventoried by the 
OpenManage Essentials server.

• PowerVault Modular Disk Storage Manager (MDSM) installed on the OpenManage Essentials server to 
support PowerVault MD Series arrays.

• A trust relationship must exist between the domains of the management server and the managed 
nodes.

• Microsoft .Net Framework 4.5

• Microsoft ASP.Net

• IIS 7.x or 8.x

• Web browser – Internet Explorer 8, 9, 10, or 11; Mozilla Firefox 22 or 23; supported only on Windows-
based operating systems.

Related Links

Minimum Requirements

Hardware Requirements

The following are the minimum recommended hardware configurations:

Hardware Medium Deployments Large Deployments

Number of managed systems Up to 500 500 to 2000

Processor 6 cores (1.8 GHz minimum) 10 cores (1.8 GHz minimum)

Memory 10 GB 12 GB

Hard drive

NOTE: If SupportAssist is 
configured to collect the 
system logs at regular 
intervals, additional hard-
drive space is required. The 
hard-drive space required 
can be determined as 10 MB 
x number of managed 
devices.

8 GB 12 GB

Related Links

Minimum Requirements

Network Requirements

The following are the minimum network requirements:

• Internet connection – standard Gbe network.

• The OpenManage Essentials management server on which the SupportAssist application is installed 
must be able to communicate with the SupportAssist server hosted by Dell over the HTTPS protocol.

• The OpenManage Essentials management server on which the SupportAssist application is installed 
must be able to connect to the following destinations:

– https://api.dell.com/support/case/v2/WebCase — end point for the SupportAssist server.
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– https://ddldropbox.us.dell.com/upload.ashx/ — the file upload server where the diagnostic test 
results are uploaded.

– https://ftp.dell.com/ — for new SupportAssist release information.

NOTE: To verify if the destinations are reachable, follow the instructions in Ensuring 
Successful Communication Between The SupportAssist Application And The SupportAssist 
Server.

• The following network ports must be open:

– On the management server: port 2607 for console launch, port 162 for SNMP, and port 443 for 
SSL communication and SupportAssist update information.

– On the managed node: port 161 for SNMP and port 1311 for OMSA.

NOTE: For information about the other dependent ports, see the “Supported Protocols and Ports” 
section in the Dell OpenManage Essentials User’s Guide at dell.com/openmanagemanuals.

Related Links

Minimum Requirements

Installing SupportAssist

You can install SupportAssist by downloading one of the following installation packages:

• Dell SupportAssist version 1.3 available at dell.com/SupportAssistGroup.

• Dell OpenManage Essentials version 1.3 available at delltechcenter.com/ome.

By installing SupportAssist, you agree to the Dell End User License Agreement — Type A, available for 
review at dell.com/softwarelicenseagreement; and the Dell Privacy Policy available for review at 
dell.com/privacy. The use of SupportAssist is also subject to the terms of the Service Agreement and 
Terms and Conditions of Sale.

Related Links

Installing SupportAssist Using The SupportAssist Installation Package

Installing SupportAssist Using The OpenManage Essentials Installation Package

Installing SupportAssist Using The SupportAssist Installation Package

To install:
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NOTE: Before you begin, make sure that:

• The system is able to connect to the Internet.

• You have Administrator privileges on the system.

• On the firewall, port 443 is open to access https://ftp.dell.com.

1. On the Dell OpenManage Essentials management server, right-click the SupportAssist installer 
package, and select Run as administrator.

NOTE: Microsoft User Access Control (UAC) requires that the installation is performed with 
elevated privileges that are obtained only through the Run as administrator option. If you are 
logged on to the OpenManage Essentials server as an administrator, double-click the installer 
package to install SupportAssist. However, ensure that you acknowledge the Open File - 
Security Warning dialog box to proceed.

The Preparing to Install dialog box is briefly displayed and then the Welcome to Dell SupportAssist 
dialog box is displayed.

NOTE: SupportAssist installation requires that you allow Dell to save certain Personally 
Identifiable Information (PII) such as your contact information, local administrator credentials, 
and so on. SupportAssist installation cannot proceed unless you allow Dell to save your PII.

2. Read the terms, and click I Agree.

The License Agreement dialog box is displayed.

3. Read the software license agreement, select I accept the terms in the license agreement, and then 
click Next.

The Registration Information dialog box is displayed.

4. Provide the following information for the primary contact to whom Dell must send alert notifications, 
case status notifications, and so on:

– Company Name — The company name must contain one or more printable characters, and must 
not exceed 256 characters.

– Country/Territory — Select your country or territory.

– First Name — The first name can contain letters, quotation marks [ ’ ], periods [ . ], spaces, and 
must not exceed 50 characters.

– Last Name — The last name can contain letters, quotation marks [ ’ ], periods [ . ], spaces, and 
must not exceed 50 characters.

– Phone Number — It must contain a minimum of 10 characters and must not exceed 50 
characters.

– Alternate Phone Number — Optional, with the same requirements as the Phone Number.

– Email Address — Provide the email address in the name@company.com format. It must contain a 
minimum of five characters and not exceed 50 characters.

– Preferred Email Language — Select the desired language for SupportAssist email notifications.

– Receive email notification when a new support case is opened — Select the check box to 
receive an email when SupportAssist creates a support case.

NOTE: After the installation of SupportAssist, you can update the primary contact information 
and also provide a secondary contact information. If the primary contact is unavailable, Dell can 
contact your company through the secondary contact. If both the primary and secondary 
contacts are configured with valid email addresses, both receive SupportAssist emails. For 
information about updating the contact information, see Viewing And Updating The Contact 
Information.

The Ready to Install the Program dialog box is displayed.
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5. Click Install.

The Install Wizard Completed dialog box is displayed.

NOTE: By default, SupportAssist is installed at: C:\Program Files (x86)\Dell\Dell Integrated 
Support.

6. Click Finish.

The SupportAssist application opens in a web browser and the First-Time Setup dialog box is 
displayed. The SupportAssist application installed on the system registers with the SupportAssist 
server hosted by Dell, and sends the registration confirmation email to your primary contact. If you 
do not receive the SupportAssist application registration email, move the mouse pointer over the 
Help link at the top-right corner of the SupportAssist dashboard, and then click About. In the About 
window, verify if a Client ID value is specified. If the Client ID value is not specified, it indicates that 
the registration was unsuccessful. To ensure that the registration is successful, follow the instructions 
in Registration Failure.

After the installation of SupportAssist is completed, the following system log collection tools are 
installed in the background:

NOTE: If the management server on which SupportAssist is installed connects to the Internet 
through a proxy server, you must configure the proxy settings in SupportAssist to enable the 
download and installation of the collection tools. See Configuring Proxy Server Settings.

– Dell System E-Support Tool (DSET) — Collection tool for Dell PowerEdge, Dell PowerVault NX 
storage servers, and iDRAC7 devices.

– Dell Lasso — Collection tool for Dell PowerVault, Dell EqualLogic, EqualLogic FluidFS NAS, Dell 
Chassis Management Controller (CMC), Dell Force10, Dell PowerConnect, blade server chassis, 
Dell PowerEdge VRTX, and PowerVault MD series devices.

NOTE: If the collection tools are already installed on the system, they are automatically 
migrated to a version compatible with SupportAssist.

NOTE: DSET and Lasso generate the system log collection from OpenManage Essentials-
managed Dell devices, then compress and upload it for use by Dell technical support to 
diagnose issues. For information about the generated system log collection, see Accessing And 
Viewing The System Log Collection.

To configure SupportAssist to monitor supported devices in the environment, after installing 
SupportAssist, follow the instructions in Setting Up SupportAssist.
Related Links

Installing SupportAssist

Installing SupportAssist Using The OpenManage Essentials Installation 
Package

To install:

NOTE: Before you begin, make sure that:

• The system is able to connect to the Internet.

• You have Administrator privileges on the system.

• On the firewall, port 443 is open to access https://ftp.dell.com.
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NOTE: If the installation of SupportAssist fails, you can retry the installation at a later time. To retry 
the installation, right-click the DellSupportAssistSetup.exe file available at C:\Program Files\Dell
\SysMgt\Essentials\SupportAssistSetup or the OpenManage Essentials custom installation folder, 
and select Run as administrator.

1. Extract the OpenManage Essentials installation package.

2. Double-click the Autorun.exe file available in the folder where you extracted the installation package.

The Dell OpenManage Install screen is displayed.

3. If OpenManage Essentials version 1.3 is not installed on the system, make sure that Dell 
OpenManage Essentials is selected.

4. Select Dell SupportAssist, and then click Install.

If you select Dell OpenManage Essentials and Dell SupportAssist, installation of OpenManage 
Essentials starts. After OpenManage Essentials is installed, the SupportAssist setup is initiated. The 
system prerequisites for installing SupportAssist are verified. If the system prerequisites are met, the 
Welcome to Dell SupportAssist Installer window is displayed.

5. Click Next.

The License Agreement window is displayed.

6. Read the terms in the communication requirements and click I Agree.

NOTE: SupportAssist installation requires that you allow Dell to save certain Personally 
Identifiable Information (PII) such as your contact information, administrator credentials of the 
devices to be monitored, and so on. SupportAssist installation cannot proceed unless you allow 
Dell to save your PII.

7. Read the software license agreement, click I Agree, and then click Next.

If the system connects to the Internet through a proxy server, the Proxy Settings window is 
displayed. Otherwise, the Registration window is displayed.

8. If the Proxy Settings window is displayed, provide the following:

a) In the Server Address field, type the proxy server address or name.

b) In the Port field, type the proxy port number.

NOTE: If the proxy server credentials are not provided, SupportAssist connects to the proxy 
server as an anonymous user.

c) If the proxy server requires authentication, select Proxy requires authentication, and then 
provide the following information in the corresponding fields:

* Username — The user name must contain one or more printable characters, and must not 
exceed 104 characters.

* Password — The password must contain one or more printable characters, and must not 
exceed 127 characters.

* Confirm Password — Reenter the password. The password must match with the one provided 
in the Password field.

d) Click Next.

The proxy settings are validated. If the validation is unsuccessful, verify the proxy settings and try 
again or contact your network administrator for assistance.

e) In the Validation Successful dialog box, click OK.

The Registration window is displayed.
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9. Provide the following information for the primary contact to whom Dell must send alert notifications, 
case status notifications, and so on:

– Company Name — The company name must contain one or more printable characters, and must 
not exceed 256 characters.

– Country/Territory — Select your country or territory.

– First Name — The first name can contain letters, quotation marks [ ’ ], periods [ . ], spaces, and 
must not exceed 50 characters.

– Last Name — The last name can contain letters, quotation marks [ ’ ], periods [ . ], spaces, and 
must not exceed 50 characters.

– Phone Number — It must contain a minimum of 10 characters and must not exceed 50 
characters.

– Alternate Phone Number — Optional, with the same requirements as the Phone Number.

– Email Address — Provide the email address in the name@company.com format. It must contain a 
minimum of five characters and not exceed 50 characters.

– Preferred Email Language — Select the desired language for SupportAssist email notifications.

– Receive email notification when a new support case is opened — Select the check box to 
receive an email when SupportAssist creates a support case.

NOTE: After the installation of SupportAssist, you can update the primary contact information 
and also provide a secondary contact information. If the primary contact is unavailable, Dell can 
contact your company through the secondary contact. If both the primary and secondary 
contacts are configured with valid email addresses, both receive SupportAssist emails. For 
information about updating the contact information, see Viewing And Updating The Contact 
Information.

10. Click Install.

The SupportAssist installation package is downloaded and installed.

NOTE: By default, SupportAssist is installed at C:\Program Files (x86)\Dell\Dell Integrated 
Support.
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11. In the Installation Completed window, select Launch SupportAssist and click Finish.

The SupportAssist application opens in a web browser and the First-Time Setup dialog box is 
displayed. The SupportAssist application installed on the system registers with the SupportAssist 
server hosted by Dell, and sends the registration confirmation email to your primary contact. If you 
do not receive the SupportAssist application registration email, move the mouse pointer over the 
Help link at the top-right corner of the SupportAssist dashboard, and then click About. In the About 
window, verify if a Client ID value is specified. If the Client ID value is not specified, it indicates that 
the registration was unsuccessful. To ensure that the registration is successful, follow the instructions 
in Registration Failure.

After the installation of SupportAssist is completed, the following system log collection tools are 
installed in the background:

– Dell System E-Support Tool (DSET) — Collection tool for Dell PowerEdge, Dell PowerVault NX 
storage servers, and iDRAC7 devices.

– Dell Lasso — Collection tool for Dell PowerVault, Dell EqualLogic, EqualLogic FluidFS NAS, Dell 
Chassis Management Controller (CMC), Dell Force10, Dell PowerConnect, blade server chassis, 
Dell PowerEdge VRTX, and PowerVault MD series devices.

NOTE: If the collection tools are already installed on the system, they are automatically 
migrated to a version compatible with SupportAssist.

NOTE: DSET and Lasso generate the system log collection from OpenManage Essentials-
managed Dell devices, then compress and upload it for use by Dell technical support to 
diagnose issues. For information about the generated system log collection, see Accessing And 
Viewing The System Log Collection.

To configure SupportAssist to monitor supported devices in the environment, after installing 
SupportAssist, follow the instructions in Setting Up SupportAssist.
Related Links

Installing SupportAssist

Verifying The Installation

To verify if the software, hardware, and network components required for SupportAssist to provide 
proactive support are configured correctly, see the Dell SupportAssist Version 1.3 For Dell OpenManage 
Essentials Quick Start Guide at dell.com/ServiceabilityTools.

Upgrading SupportAssist

NOTE: Upgrade to SupportAssist version 1.3 is supported only if OpenManage Essentials version 1.3 
is installed on the system. For information on installing OpenManage Essentials version 1.3, see the 
OpenManage Essentials Version 1.3 User’s Guide at dell.com/OpenManageManuals.

You can upgrade SupportAssist version 1.1, 1.1.1, 1.2, or 1.2.1 to version 1.3. To upgrade SupportAssist, 
download one of the following:

• SupportAssist version 1.3 installation package available at dell.com/SupportAssistGroup.

• Dell OpenManage Essentials version 1.3 installation package available at delltechcenter.com/ome.
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Upgrading SupportAssist Using The SupportAssist Installation Package

To upgrade:

1. On the Dell OpenManage Essentials management server, right-click the SupportAssist installer 
package, and select Run as administrator.

NOTE: UAC requires that the installation is performed with elevated privileges that are obtained 
only through the Run as administrator option. If you are logged on to the OpenManage 
Essentials server as an administrator, double-click the installer package to install SupportAssist. 
However, ensure that you acknowledge the Open File - Security Warning dialog box to 
proceed.

The Dell SupportAssist - InstallShield Wizard dialog box is displayed.

2. At the This setup will perform an upgrade of 'Dell SupportAssist'. Do you want to continue? 
prompt, click Yes.

The Preparing to Install dialog box is briefly displayed, and then the Resuming the Install Wizard for 
SupportAssist dialog box is displayed.

3. Click Next.

The Install Wizard Completed dialog box is displayed.

4. Click Finish.

The SupportAssist application opens in a web browser and the First-Time Setup screen is displayed.

NOTE: After the upgrade of SupportAssist, the Dell collection tools required by SupportAssist 
are downloaded and installed in the background. If the collection tools are already installed on 
the system, they are automatically migrated to a version compatible with SupportAssist.

NOTE: The Service Contract column in the SupportAssist dashboard displays unknown for all 

support cases created prior to the SupportAssist upgrade. Once an alert is received from the device, 
the Service Contract column is updated with the appropriate service contract type.

Upgrading SupportAssist Using The OpenManage Essentials Installer 
Package

To upgrade:

1. Double-click the OpenManage Essentials executable file.

The Dell OpenManage Install screen is displayed.

NOTE: If SupportAssist is already installed on the system, by default, the Dell SupportAssist 
option is selected and grayed out.

2. Click Install.

The Welcome to Dell SupportAssist Installer window is displayed.
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3. If the Proxy Settings window is displayed, provide the following:

a) In the Server Address field, type the proxy server address or name.

b) In the Port field, type the proxy port number.

NOTE: If the proxy server credentials are not provided, SupportAssist connects to the proxy 
server as an anonymous user.

c) If the proxy server requires authentication, select Proxy requires authentication, and then 
provide the following information in the corresponding fields:

* Username — The user name must contain one or more printable characters, and must not 
exceed 104 characters.

* Password — The password must contain one or more printable characters, and must not 
exceed 127 characters.

* Confirm Password — Reenter the password. The password must match with the one provided 
in the Password field.

d) Click Next.

The proxy settings are validated. If the validation is unsuccessful, verify the proxy settings and try 
again or contact your network administrator for assistance.

e) In the Validation Successful dialog box, click OK.

The Installation Completed window is displayed.

NOTE: After the upgrade of SupportAssist, the Dell collection tools required by SupportAssist 
are downloaded and installed in the background. If the collection tools are already installed on 
the system, they are automatically migrated to a version compatible with SupportAssist.

NOTE: The Service Contract column in the SupportAssist dashboard displays unknown for all 

support cases created prior to the SupportAssist upgrade. Once an alert is received from the 
device, the Service Contract column is updated with the appropriate service contract type.

Uninstalling SupportAssist

To uninstall:

NOTE: Uninstalling SupportAssist also uninstalls the associated Dell collection tools. If the collection 
tools are running during the uninstallation, a message is displayed.

1. On the OpenManage Essentials management server, click Start → Control Panel → Programs and 
Features.

The Programs and Features window is displayed.

2. Select Dell SupportAssist, and then click Uninstall.

3. If the Programs and Features dialog box is displayed, prompting you to confirm the uninstallation, 
click Yes.

SupportAssist and the associated system log collection tools are now uninstalled from your 
OpenManage Essentials server.

NOTE: All device, case, service contract, and user-entered information are removed when you 
uninstall SupportAssist. If you reinstall SupportAssist, it registers with the SupportAssist server as a 
new client. The support case information that was generated prior to uninstalling SupportAssist is 
not displayed.
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3
Using Dell SupportAssist
The following sections provide information about configuring and using SupportAssist.

Launching SupportAssist

To launch SupportAssist:

1. On the OpenManage Essentials management server:

– Double-click the Dell SupportAssist desktop icon.

– Click Start→ All Programs→ Dell OpenManage Applications→ SupportAssist→ SupportAssist.

– In OpenManage Essentials console, click the Extensions tab, and then click the SupportAssist 
Launch link.

The Windows Security dialog box may be displayed.

2. If the Windows Security dialog box is displayed, type the User name and Password, and then click 
OK.

The SupportAssist dashboard opens in a web browser, and may display the First-Time Setup dialog box.

NOTE: The recommended screen resolution for optimally viewing the SupportAssist dashboard is 
1280 x 1024 or higher.

Setting Up SupportAssist

To ensure that SupportAssist is able to monitor the supported devices, generate support cases if there is a 
problem with any devices, and transmit the system logs to Dell, perform the following:

1. Establish Internet connectivity — If your system connects to the Internet through a firewall or proxy 
server, the proxy server settings must be configured in SupportAssist. See Configuring Proxy Server 
Settings.

NOTE: You must update the proxy server settings in SupportAssist whenever the proxy server 
settings in your environment are changed.

2. Establish system log collection — Configure the Default Device Type Credentials in the System Logs 
page for each Device Type and Credential Type. See Configuring The Default Device Type 
Credentials.

3. Rediscover Dell Force10 switch/router — If you had discovered and inventoried Force10 switch/
router in OpenManage Essentials version 1.2, and then upgraded to OpenManage Essentials version 
1.3, you must rediscover the Force10 switch/router in OpenManage Essentials. For information on 
discovering devices, see the Dell OpenManage Essentials User's Guide at dell.com/
OpenManageManuals or the OpenManage Essentials context-sensitive help.
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Configuring Proxy Server Settings

If your system connects to the Internet through a firewall or proxy server, the proxy settings must be 
configured in SupportAssist. Configuring the proxy settings enables the SupportAssist application to 
communicate with the SupportAssist server hosted by Dell.

To configure the proxy server settings:

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators or Power Users group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Click Proxy Settings.

The Proxy Settings page is displayed.

3. Select Use Proxy Settings.

NOTE: SupportAssist supports Windows NT LAN Manager (NTLM) authentication protocol only.

4. Type the Proxy Server Address or Name and Proxy Port Number details.

NOTE: If the proxy server credentials are not provided, SupportAssist connects to the proxy 
server as an anonymous user.

5. If the proxy server requires authentication, select Proxy requires authentication, and then provide 
the following information in the corresponding fields:

– Username — The user name must contain one or more printable characters, and not exceed 104 
characters.

– Password — The user password must contain one or more printable characters, and not exceed 
127 characters.

– Confirm Password — Repeat the user password. The password should match with the one 
provided in the Password field.

6. Click Apply.

SupportAssist tests the proxy server settings, and the result of the test is displayed in a dialog box.

Related Links

Proxy Settings

Configuring The Default Device Type Credentials

SupportAssist runs the appropriate collection tools and gathers the system logs from OpenManage 
Essentials-managed Dell server, storage, and switch devices. To run the collection tools on your 
supported devices, you must configure SupportAssist with the Administrator credentials for each 
managed device type. The Default Device Type Credentials section in the System Logs page allows you 
to configure SupportAssist with the Administrator credentials for each supported device type and 
credential type.
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NOTE: Whenever the Administrator credentials of supported devices are changed, you must ensure 
that the Default Device Type Credentials are also updated in SupportAssist. Alternately, you can 
create a service account that never expires, and provide the service account credentials in 
SupportAssist.

For example, if the managed PowerEdge servers are part of a domain, you can create a service 
account on the domain controller, and add the service account to the Local Administrators group of 
the managed server. Then provide the service account credentials in the Default Device Type 
Credentials page in SupportAssist. For more information, see the Managing Device Credentials in 
SupportAssist Using Service Account technical white paper at dell.com/SupportAssistGroup.

To configure the default device type credentials:

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators or Power Users group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Under Edit Device Credentials, select the Device Type from the list. You can select from:

– Server

– Storage

– Switch

3. Select the Credential Type from the list. The options listed vary based on the Device Type you 
selected.

The options for Server are:

– Windows

– Linux

– ESX/ESXi

– iDRAC7

– CMC

The options for Storage are:

– EqualLogic

– MD Series

– NAS Appliance

The options for Switch are:

– PowerConnect

– Force10
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4. Type the credentials in the corresponding fields:

NOTE: For Force10 and PowerConnect Ethernet switches, the Username, Password, and 
Enable Password fields are optional. However, information must be provided for these fields if 
the Force10 or PowerConnect Ethernet switch is configured with these details.

– Username — The user name must contain one or more printable characters, and not exceed 104 
characters.

NOTE: Windows user names must be of the form [Domain\Username]. You can also use a 
period [ . ] to indicate the local domain. This rule does not apply to Linux or ESX/ESXi 
credentials.

NOTE: For Force 10 and PowerConnect Ethernet switches the domain name need not be 
specified.

Examples of Windows user names: .\Administrator; MyDomain\MyUsername

Example of Linux, ESX/ESXi user name: Username

– Password — The user password must contain one or more printable characters, and not exceed 
127 characters.

– Enable Password — For Ethernet switches only. The enable password must contain one or more 
printable characters, and not exceed 127 characters.

– Community String — For EqualLogic storage arrays and EqualLogic FluidFS NAS appliances only. 
The community string of the storage device.

NOTE: The Default Device Type Credentials are encrypted and saved locally.

5. Repeat step 2 to step 4 until you have configured the default credentials for all device types in your 
environment.

6. Click Save Changes.

If the credentials for a device differs from the Default Device Type Credentials you provided, you can edit 
the device credentials for that particular device. For more information about providing the credentials for 
a specific device, see Editing Device Credentials.
Related Links

System Logs

Editing Device Credentials

Testing SupportAssist Connectivity

The connectivity test enables you to test the connectivity between the SupportAssist application installed 
on the management server and the SupportAssist server hosted by Dell. You can test the SupportAssist 
connectivity status, to ensure that you receive the most current case and device updates. For example, 
you may want to check the connectivity status following a network outage, a router or firewall 
configuration change, or change made to the email address of the primary user.

To test the SupportAssist connectivity status:
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NOTE: The Connectivity Test link is enabled only if you are logged on as a member of the 
OpenManage Essentials Administrators or Power Users group.

1. Move the mouse pointer over the user name link that is displayed beside the Help link, and then click 
Connectivity Test.

The Connectivity Test page is displayed.

2. Click Send.

NOTE: If you have opted to not receive email notification when a new support case is 
generated, SupportAssist does not send the connectivity confirmation email as well. For more 
information about email notification settings, see Configuring Email Notification Settings.

SupportAssist initiates the connectivity test.

– If the test is successful, a confirmation email message is sent to you. The message provides the 
connectivity status and a reminder to configure your devices for monitoring. The SupportAssist 
dashboard displays the following message:

A connectivity test has been successfully sent to Dell SupportAssist.
When you receive the connectivity confirmation email from SupportAssist, ensure that your 
supported Dell devices are properly configured for monitoring. For more information, see the Dell 
OpenManage Essentials User’s Guide at dell.com/openmanagemanuals.

– If the connectivity test fails, the following error message is displayed:

Error: Connectivity test failed. Please check your network settings. If 
your network settings are correct, please contact Dell Technical Support 
for further instructions.

* If SupportAssist displays an error message, follow the instructions in Ensuring Successful 
Communication Between The SupportAssist Application And The SupportAssist Server, and 
then click Retry. If the error persists, and you are certain that your network settings are 
correct, click the Dell Technical Support link that appears below the error message to engage 
Dell technical support for troubleshooting assistance. Once the error is resolved, repeat step 1 
to step 2.

Related Links

Connectivity Test

Filtering The System Log Collection

The system logs collected by SupportAssist includes personally identifiable information (PII) such as the 
complete configuration snapshot of storage systems, hosts, and network devices which can contain host 
identification and network configuration data.

In most cases, part or all of this data is required to properly diagnose issues. The security policy of your 
company may restrict sending this data outside of your network. You can prevent sending this data to 
Dell by configuring SupportAssist to filter the system log collection.

The following is the network identity information that you can filter from the system log collection:

• Host name

• IP address

• Subnet mask

• Default gateway

• MAC address

• DHCP server
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• DNS server

• Processes

• Environment variables

• Registry

• Logs

• iSCSI data

NOTE: When the Send network identification information to Dell option is cleared, some of the 
data about your network is not transmitted to Dell. This may impede Dell technical support from 
resolving your issue.

NOTE: If your devices are covered under the Dell ProSupport Plus service contract, when the Send 
network identification information to Dell option is disabled, you will not receive some reporting 
information about your devices.

To filter the system log collection:

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators or Power Users group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Click Preferences.

The Preferences page is displayed.

3. Under System Log Collection Details, clear the Send network identification information to Dell 
option.

NOTE: By default, the Send network identification information to Dell option is selected.

4. Click Save Changes.

Related Links

Preferences

Editing Device Credentials

The Default Device Type Credentials that you provided for each Device Type and Credential Type in the 
System Logs page is used to run the collection tools on your managed devices and gather the system 
logs. If the credentials for a particular device differ from the Default Device Type Credentials you 
provided, you can edit the credentials for that device.

CAUTION: After you edit the credentials for a specific device, SupportAssist uses the device-
specific credentials you provided to collect the system logs on that device.

NOTE: To ensure that SupportAssist is able to generate the system log collection for all devices, you 
must edit the credentials for each device which has credentials that are not the same as the Default 
Device Type Credentials.

To edit the credentials for a device:

26



NOTE: Editing the credentials for a device is enabled only if you are logged on as a member of the 
OpenManage Essentials Administrators or Power Users group.

1. Click the Devices tab.

The Device Inventory page is displayed.

2. Select a device in the Device Inventory table.

The Edit Device Credentials link is enabled.

3. Click Edit Device Credentials.

NOTE: If the device you selected does not require credentials to generate the system log 
collection, a message is displayed on the dashboard.

The Edit Device Credentials dialog box is displayed.

4. Type the Username, Password, Enable Password (if applicable), and Community String (if applicable) 
in the appropriate fields.

5. Click Save Changes.

The Confirmation dialog box is displayed.

CAUTION: If you select the Do not show this reminder again option, SupportAssist does not 
prompt for your confirmation when you attempt to edit the device credentials the next time.

6. Click Yes.

The dashboard displays the following message: Your device credentials were saved 
successfully.

Related Links

Device Inventory

Viewing The Device Inventory

Configuring The Default Device Type Credentials

Resetting The Device-Specific Credentials To The Default Device Type Credentials

Overwriting The Device-Specific Credentials With The Default Device Type Credentials

Resetting The Device-Specific Credentials To The Default 
Device Type Credentials

If you had edited the credentials for a particular device, and later want to reset the credentials for that 
device to the Default Device Type Credentials, you can do so using the Edit Device Credentials dialog 
box.

CAUTION: Resetting to the Default Device Type Credentials overwrites the device-specific 
credentials with the default credentials. After you reset the credentials, SupportAssist uses the 
Default Device Type Credentials to collect the system logs on that device.

NOTE: You can reset the device-specific credentials to the Default Device Type Credentials for 
only one device at a time using the Edit Device Credentials dialog box. To overwrite the device-
specific credentials for multiple devices belonging to a particular Device Type and Credential Type 
at a time, see Overwriting The Device-Specific Credentials With The Default Device Type 
Credentials.

To reset the device-specific credentials to the default device type credentials:
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NOTE: To reset the device-specific credentials to the Default Device Type Credentials, you must be 
logged on as a member of the OpenManage Essentials Administrators or Power Users group.

1. Click the Devices tab.

The Device Inventory is displayed.

2. Select a device in the Device Inventory table.

The Edit Device Credentials link is enabled.

3. Click Edit Device Credentials.

The Edit Device Credentials dialog box is displayed.

4. Click Reset to Default Device Type Credentials.

NOTE: The Reset to Default Device Type Credentials link is displayed only if you had previously 
configured the selected device with specific credentials.

The Confirmation dialog box is displayed.

CAUTION: If you select the Do not show this reminder again option, SupportAssist does not 
prompt for your confirmation when you attempt to reset the device-specific credentials the 
next time.

5. Click Yes.

Related Links

Device Inventory

Viewing The Device Inventory

Editing Device Credentials

Overwriting The Device-Specific Credentials With The 
Default Device Type Credentials

If you had edited the credentials for several devices, and later want to overwrite the credentials for all 
those devices to the Default Device Type Credentials, you can do so using the System Logs page.

CAUTION: Once you overwrite the device-specific credentials, the Default Device Type 
Credentials overwrites the credentials of devices that you had previously edited through the Edit 
Device Credentials link.

NOTE: You can overwrite the device-specific credentials to the Default Device Type Credentials for 
all devices belonging to a particular Device Type and Credential Type at a time through the System 
Logs page. To reset the device-specific credentials for only a particular device, see Resetting The 
Device-Specific Credentials To The Default Device Type Credentials.

To reset the device-specific credentials to the default device type credentials:

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators or Power Users group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Select the device category from the Device Type list.

3. Select the credential category from the Credential Type list.
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4. Select Overwrite the device-specific credentials with the Default Device Type Credentials for all 
devices belonging to the current Device Type and Credential Type.

The Confirmation dialog box is displayed.

CAUTION: If you select the Do not show this reminder again option, SupportAssist does not 
prompt for your confirmation when you attempt to overwrite the device-specific credentials 
the next time.

5. Click Yes.

6. Click Save Changes.

Related Links

System Logs

Editing Device Credentials

Sending The System Logs Manually

When a support case is opened or updated, the SupportAssist application, runs the collection tools on the 
devices that generated the alerts, and then uploads the system logs to Dell. In certain conditions, if 
required by Dell technical support, you may be required to manually collect the system logs and send it 
to Dell.

To send the system logs manually:

NOTE: The Send System Logs option is enabled only if you are logged on as a member of the 
OpenManage Essentials Administrators or Power Users group.

1. Click the Devices tab.

The Device Inventory is displayed.

2. Select a device in the Device Inventory table.

The Send System Logs link is enabled.

3. Click Send System Logs.

The Collection Status column in the Device Inventory displays the status of the collection and 
upload of the system logs.

Related Links

Device Inventory

Viewing The Device Inventory

Enabling Or Disabling The Automatic Collection Of 
System Logs

By default, when a support case is opened or updated, SupportAssist is configured to automatically 
collect the system logs from the device that generated the alert and upload it to Dell.

To enable or disable the automatic collection of system logs:
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NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators or Power Users group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Click Preferences.

The Preferences page is displayed.

3. Under Support Collection, select or clear Automatically start a log collection when a new support 
case is generated, to enable or disable the automatic collection of system logs.

NOTE: By default, the Automatically start a log collection when a new support case is 
generated option is selected.

4. Click Save Changes.

Related Links

Preferences

Enabling Or Disabling The Scheduling Of System Log 
Collection

By default, SupportAssist is configured to collect the system logs from supported devices at periodic 
intervals and upload it to Dell. For information about the default frequency of the collection of system 
logs, see Default System Log Collection Schedule. You can also customize the frequency of the 
collection of system logs for each device type. For more information, see Scheduling The Periodic 
Collection Of System Logs.

To enable or disable the scheduling of system log collection:

NOTE: Selecting the Enable system log collection scheduling option enables the collection and 
upload of system logs at periodic intervals from all supported device types. If you do not want 
SupportAssist to collect the system logs for a specific device type, you can disable scheduling for 
that specific device through the System Logs tab. For more information, see Disabling Scheduling 
Of System Log Collection For A Specific Device Type.

To enable scheduling of system log collection:

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators or Power Users group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Click Preferences.

The Preferences page is displayed.

3. Under Support Collection, select or clear Enable system log collection scheduling, to enable or 
disable scheduling of the collection of system logs.

NOTE: By default, the Enable system log collection scheduling option is selected.

4. Click Save Changes.

Related Links

Preferences

Disabling The Scheduling Of System Log Collection For A Specific Device Type
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Scheduling The Periodic Collection Of System Logs

Before you begin, ensure that the Enable system log collection scheduling option is enabled in the 
Preferences page.

NOTE: To receive the full benefits of the support, reporting, and maintenance offering of your 
ProSupport Plus service contract, you must configure SupportAssist to collect the system logs at 
periodic intervals for each supported device type.

To schedule the periodic collection of system logs:

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators or Power Users group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Under Edit Device Type Credentials, select the Device Type from the list. You can select from:

– Server

– Storage

– Switch

3. Select the Credential Type from the list. The options listed vary based on the Device Type you 
selected.

The options for Server are:

– Windows

– Linux

– ESX/ESXi

– iDRAC7

– CMC

The options for Storage are:

– EqualLogic

– MD Series

– NAS Appliance

The options for Switch are:

– PowerConnect

– Force10

4. Verify or provide the credentials (Username, Password, Confirm Password, Community String) for 
the selected credential type. For more information, see Configuring The Default Device Type 
Credentials.

5. Under System Log Collection Schedule, set the Frequency to Weekly or Monthly.

NOTE: If you want to disable the scheduling of system logs for a specific Device Type and 
Credential Type, set the Frequency to None.

6. In the Specify date and time fields, select an appropriate schedule. The options available vary based 
on the selected Frequency.

7. Repeat step 2 to step 5 until you have scheduled the periodic collection of system logs for all device 
types in your environment.
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8. Click Save Changes.

Related Links

System Logs

Default System Log Collection Schedule

Disabling The Scheduling Of System Log Collection For A Specific Device Type

Network Bandwidth Consumption And 
Recommendations For Scheduling Periodic Collection

NOTE: In an environment that consists of less than 300 devices, the network bandwidth consumed 
for uploading the system log collection is about 4 MB/second.

The following table provides information about network bandwidth consumption and recommendations 
for scheduling periodic collections in an environment that consists of 75 percent servers and 25 percent 
switch and storage devices. The recommendations also assume compliance with the hardware, software, 
and networking requirements for SupportAssist.

Total number of 
devices

Network bandwidth 
consumed for 
uploading the 
collection (GB/month)

Time taken for 
generating the 
collection (hours)

Recommendations for 
scheduling periodic 
collection

Less than 300 16 20 Weekly (overnight)

300 or more 7.2 to 47 22.5 For EqualLogic and 
Force10 devices — 
Weekly (overnight)

For Dell PowerEdge and 
Dell PowerConnect 
devices — Monthly (at 
different times during 
the week for each 
device type)

Default System Log Collection Schedule

The following table provides the default system log collection schedule for each supported device.

Device Type Device or Operating System Schedule

Server Windows Monthly; Monday of the first 
week at 12:00 AM

Linux Monthly; Monday of the first 
week at 12:00 AM

ESX/ESXi Monthly; Monday of the first 
week at 12:00 AM

iDRAC7 Monthly; Monday of the first 
week at 12:00 AM

CMC Monthly; Monday of the first 
week at 12:00 AM
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Device Type Device or Operating System Schedule

Storage Dell EqualLogic Weekly; Monday at 12:00 AM

Dell PowerVault MD series Weekly; Monday at 12:00 AM

NAS appliance Weekly; Monday at 12:00 AM

Switch Dell PowerConnect Monthly; Monday of the first 
week at 12:00 AM

Dell Force 10 Weekly; Monday at 12:00 AM

Related Links

Scheduling The Periodic Collection Of System Logs

Disabling The Scheduling Of System Log Collection For A Specific Device Type

Disabling The Scheduling Of System Log Collection For A 
Specific Device Type

To disable the scheduling of system log collection for a specific device type:

NOTE: Disabling the scheduling of system log collection for a specific device type only disables the 
generation of system log collection at periodic intervals on those devices. It does not disable 
SupportAssist from generating a system log collection and uploading it to Dell, if a support case is 
opened for those devices.

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators or Power Users group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Under Edit Device Credentials, select the Device Type for which you want to disable scheduling. 
You can select from:

– Server

– Storage

– Switch

3. Select the Credential Type for which you want to disable scheduling. The options available vary 
based on the Device Type you selected.

4. In System Log Collection Schedule section, set the Frequency to None.

5. Click Save Changes.

The following message is displayed in the System Log Collection Schedule section: System Log 
Collection scheduling is turned off for the current Device Type and 
Credential Type.

Related Links

Default System Log Collection Schedule

Scheduling The Periodic Collection Of System Logs

Enabling Or Disabling The Scheduling Of System Log Collection
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Confirming Connectivity Through The Proxy Server

To test if SupportAssist can connect to the Internet through the proxy server:

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators or Power Users group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Click Proxy Settings.

The Proxy Settings page is displayed.

3. Ensure that the proxy settings has been configured correctly. See Configuring Proxy Server Settings.

4. Click Apply.

A dialog box appears to inform the status of the connection through the proxy server.

Auto Update

NOTE: It is recommended that you enable auto update to ensure that SupportAssist is up-to-date 
with the latest features and enhancements.

The auto update feature, when enabled, ensures that SupportAssist and the associated collection tools 
are automatically updated, when an update is available. By default, the SupportAssist application checks if 
any updates are available, every Monday at 11 am (management server date and time). If updates are 
available:

• If auto update is enabled, the updates are downloaded and automatically installed in the background.

• If auto update is disabled, the Update Available notification window is displayed. You can click Install 
to download and install the latest updates.

To enable auto update, see Enabling Auto Update.

If you click Cancel in the Update Available notification window or an error occurs during the update 

process, the  Update Available notification is displayed in the SupportAssist header. You can click the 
Update Available notification to download and install the updates at a later time.

NOTE: After the updates are downloaded and installed, an update successful message is displayed. 
To view and use the latest updates and enhancements, you must refresh the SupportAssist 
dashboard.

The log file, AutoUpdate-log-file.txt, related to the SupportAssist update can be located at C:\Program 
Files (x86)\Dell\Dell Integrated Support\logs.

Enabling Auto Update

To enable auto update:
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NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators or Power Users group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Click Preferences.

The Auto Update,Email Settings, Support Collection, and Maintenance Mode page is displayed.

3. Under Auto Update, select Enable auto update.

4. Click Save Changes.

Related Links

Preferences

Configuring Email Notification Settings

You can configure the e-mail notification settings based on your:

• Preference to receive email notifications from SupportAssist

• Preferred language

To configure the e-mail notification settings:

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators or Power Users group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Click Preferences.

The Auto Update, Email Settings, Support Collection, and Maintenance Mode page is displayed.

3. To receive e-mail notifications when a new support case is opened, under Email Settings, select 
Receive email notification when a new support case is opened.

NOTE: Disabling support case e-mail notifications also disables e-mail connectivity test e-mails.

4. To set the language in which you want to receive e-mail notifications, from the Preferred Email 
Language list, select a language.

NOTE: The Preferred Email Language is enabled only when the Receive email notification 
when a new support case is opened option is selected.

5. Click Save Changes.

Related Links

Preferences

Setting SupportAssist To Maintenance Mode

SupportAssist can also be set in or out of Maintenance Mode. Maintenance Mode disables automatic case 
generation activity, thereby allowing you to make infrastructure changes without generating unnecessary 
alerts.

To set SupportAssist in or out of Maintenance Mode:
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NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators or Power Users group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Click Preferences.

The Auto Update, Email Settings, Support Collection, and Maintenance Mode page is displayed.

3. Under Maintenance Mode, select or clear Temporarily suspend case generation activity (for 
example, for purposes of downtime, external troubleshooting, etc.) to toggle the Maintenance 
Mode status.

– If you select this option, SupportAssist is placed in maintenance mode.

– If you clear this option, SupportAssist is taken out of maintenance mode.

4. Click Save Changes.

A banner appears along the top of the SupportAssist dashboard displaying Maintenance Mode.

Once manually placed in maintenance mode, SupportAssist remains in that state unless you clear the 
option as in step 3.

NOTE: The Maintenance Mode functionality, when set manually, differs from the manner in 
which the Maintenance Mode feature handles event storms. See Event Handling for more 
information.

Related Links
Preferences

Viewing The Case List

To view the Case List, click the Cases tab on the SupportAssist dashboard. A progress indicator may 
appear at the bottom of the report to indicate that SupportAssist is in the process of updating the cache 
of open support cases.

NOTE: By default, the case list is sorted by Date Opened, in descending order.

NOTE: Pre-existing support cases (opened prior to SupportAssist installation), and cases opened by 
contacting Dell technical support, do not appear in the Case List report.

NOTE: The Service Contract column in the SupportAssist dashboard displays unknown for all 

support cases created prior to the SupportAssist upgrade. Once an alert is received from the device, 
the Service Contract column is updated with the appropriate service contract type.

Support case information is automatically available, for supported devices with valid service tags when 
SupportAssist connects to the Dell support case and service contract databases over the Internet.

NOTE: If you do not have Internet access, case information is not populated. It is downloaded and 
displayed when you next connect to the Internet and open the Case List report.

Once SupportAssist has completed its open support cases update, the Case List displays the current 
cases.

Related Links
Case List

Sorting The Case List Data By Column Name

Filtering The Case List Data By Column Name And Keyword

Returning The Case List Data To The Default Sorting
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Setting The Number Of Cases Displayed Per Page

Refreshing The Case List Or Device Inventory Display Data

Sorting The Case List Data By Column Name

To sort the case list display data by column name, click any column header. The report refreshes to 
display the data in an ascending or descending order of the column header you clicked.

Related Links

Case List

Viewing The Case List

Filtering The Case List Data By Column Name And 
Keyword

To filter the case list display data by column name and keyword:

1. Select the column name from the Filter By: list.

2. If you are searching for Case Status, Progress, Device Type, or Service Contract, select the search 
criteria from the search list.

3. If you are searching for Case Number, Date Opened, Case Title, or Service Tag, type the search 
keyword in the search text field.

4. Click Apply Filters.

The report refreshes to display the data according to your criteria. If there are no matches, the 
following message is displayed:

No support cases found. Please review your search criteria and try again.
5. To clear the search criteria and try again, click Clear Filters.

The report refreshes to display the default content.

6. Repeat step 1 through step 4.

The report refreshes to display the data according to your criteria.

Related Links

Case List

Viewing The Case List

Returning The Case List Data To The Default Sorting

To return to the default Case List view (Date Opened, in descending order), click the Cases tab.

The report refreshes to the default sorting criteria. Any new cases or updates to the current cases appear 
in the report. Cases that are closed since the last refresh no longer appear.

Related Links

Case List

Viewing The Case List

Setting The Number Of Cases Displayed Per Page

To change the total number of rows displayed in a page, select the number of cases to display from the 
Display Cases: list. You can choose from:
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• 10 per page

• 20 per page

• 30 per page

• 50 per page

• 100 per page

By default, the dashboard is set to display 50 cases per page.

Related Links

Case List

Viewing The Case List

Viewing The Device Inventory

To view the Device Inventory, click the Devices tab on the SupportAssist dashboard.

NOTE: By default, the Device Inventory is sorted by Device Name, in ascending order. See the 
following sections for more sorting options.

Related Links

Device Inventory

Editing Device Credentials

Sending The System Logs Manually

Resetting The Device-Specific Credentials To The Default Device Type Credentials

Sorting The Device Inventory Data By Column Name

Filtering The Device Inventory Data By Column Name And Keyword

Returning The Device Inventory Data To The Default Sorting

Setting The Number Of Devices Displayed Per Page

Refreshing The Case List Or Device Inventory Display Data

Sorting The Device Inventory Data By Column Name

To sort the device inventory display data by column name, click any column header. The report refreshes 
to display the data in an ascending or descending order of the column header you clicked.
Related Links

Device Inventory

Viewing The Device Inventory

Filtering The Device Inventory Data By Column Name And 
Keyword

To filter the device inventory display data by column name and keyword:

1. Select the column name from the Filter By: list.

2. If you are searching for Device Type, select the search criteria from the search list.

3. If you are searching for Device Name, Service Tag, or Collection Status, type the search keyword in 
the search text field.
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4. Click Apply Filters.

The report refreshes to display the data according to your criteria. If there are no matches, the 
following message is displayed:

No support cases found. Please review your search criteria and try again.
5. To clear the search criteria and try again, click Clear Filters.

The report refreshes to display the default content.

6. Repeat step 2 through step 3.

The report refreshes to display the data according to your criteria.

Related Links

Device Inventory

Viewing The Device Inventory

Returning The Device Inventory Data To The Default 
Sorting

To return to the default Device Inventory view (Device Name, in ascending order), click the Devices tab.

The report refreshes to the default sorting criteria. Any newly-discovered devices appear in the report. 
Devices that have been removed since the last refresh no longer appear.

Related Links

Device Inventory

Viewing The Device Inventory

Setting The Number Of Devices Displayed Per Page

To change the total number of rows displayed in a page, select the number of cases to display from the 
Display Devices: list. You can choose from:

• 10 per page

• 20 per page

• 30 per page

• 50 per page

• 100 per page

By default, the dashboard is set to display 50 devices per page.

Related Links

Device Inventory

Viewing The Device Inventory

Refreshing The Case List Or Device Inventory Display 
Data

The Case List or Device Inventory display data can be refreshed in two ways:

• Click the  icon that appears in the Case List or Device Inventory dashboard to update the displayed 
data using the currently selected filters. This is handy for displaying updated information between poll 
cycles.
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• Click the Refresh button on the web browser to regenerate the last sort operation. The web browser 
may display a dialog box with the following message:

To display the webpage again, the web browser needs to resend the 
information you’ve previously submitted.
If you were making a purchase, you should click Cancel to avoid a duplicate 
translation. Otherwise, click Retry to display the webpage again.
In the dialog box that is displayed, click the Retry button to continue.

Related Links

Case List

Viewing The Case List

Device Inventory

Viewing The Device Inventory

Viewing And Updating The Contact Information

To view and update the contact information:

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators or Power Users group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Click Contact Information.

The Contact Information page is displayed.

3. Select the type of contact:

– Primary

– Secondary

4. Make the required changes to any of the following fields:

– First Name — The first name can contain letters, quotation marks [ ’ ], periods [ . ], spaces, and not 
exceed 50 characters.

– Last Name — The last name can contain letters, quotation marks [ ’ ], periods [ . ], spaces, and not 
exceed 50 characters.

– Phone Number — In 123-456-7890 format, or in 123-456-7890 x 123 format (to include an 
extension). It must contain a minimum of 10 characters, and not exceed 50 characters.

– Alternate Phone Number — Optional, with the same format and character requirements as the 
Phone Number.

– Email Address — Provide the e-mail address in the name@company.com format. It must contain 
a minimum of five characters, and not exceed 50 characters.

5. Click Save Changes.

Related Links

Contact Information

Ensuring Successful Communication Between The 
SupportAssist Application And The SupportAssist Server

The SupportAssist application installed on the management server must be able to communicate with the 
SupportAssist server hosted by Dell to:
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• Automatically create a support case if there is a problem with a device in your environment.

• Upload the generated system log collection to Dell.

• Verify if an updated version of SupportAssist is available.

To ensure that the SupportAssist application is able to successfully communicate with the SupportAssist 
server:

• The management server on which the SupportAssist application is installed must be able to connect 
to the following destinations:

– https://api.dell.com/support/case/v2/WebCase — end point for the SupportAssist server. On the 
management server, verify if you can access the following location using the web browser: 
https://api.dell.com/support/case/v2/WebCase?wsdl.

– https://ddldropbox.us.dell.com/upload.ashx/ — the file upload server where the diagnostic test 
results are uploaded.

– Verify if port 443 is open on the management server for ddldropbox.us.dell.com and ftp.dell.com. 
You can use a telnet client to test the connection. For example, use the following command: o 
ddldropbox.us.dell.com 443.

– https://ftp.dell.com/ — for new SupportAssist release information. On the management server, 
verify if you can access the following location using the web browser: https://ftp.dell.com/.

• Verify if the server certificate on ddldropbox.us.dell.com is valid. For more information, see Verifying 
The Server Certificate.

• Verify if the network settings on the management server are correct.

• If the management server on which SupportAssist is installed connects to the Internet through a proxy 
server, configure the proxy settings in SupportAssist. See Configuring Proxy Server Settings.

If the communication problem persists, contact your network administrator for further assistance.

Verifying The Server Certificate

To verify the server certificate on ddldropbox.us.dell.com:

1. Open https://ddldropbox.us.dell.com in a web browser.

A 404 — File or directory not found error may be displayed.

2. On the address bar, click the Security Report icon , and then click View Certificates.

The Certificate is displayed.

3. In the General tab, verify if the certificate displays a valid date.

4. Click the Certification Path tab, and verify if the GTE CyberTrust Global root certificate is listed.

Verifying The Installation Of The Collection Tools

SupportAssist uses the following collection tools to generate the system log collection from supported 
devices in an environment:

• Dell System E-Support Tool (DSET)

• Dell Lasso

The collection tools are automatically downloaded and installed in the background after the installation 
of SupportAssist. To successfully generate the system log collection, the collection tools must be of a 
version that is compatible with SupportAssist.

41



To verify if a compatible version of the collection tool is installed:

1. Navigate to the Control Panel.

2. Click Programs → Programs and Features.

The Uninstall or change a program window is displayed.

3. In the list of installed applications, verify if the compatible version of DSET and Lasso are installed.

NOTE: For information on the version of DSET and Lasso that is compatible with SupportAssist, 
see the Dell SupportAssist Support Matrix at dell.com/serviceabilitytools.

Accessing And Viewing The Logs

The SupportAssist dashboard stores Windows events and log messages in two locations:

• The Windows Event Log

• The dashboard installation logs directory (typically, C:\Program Files (x86)\Dell\Dell Integrated 
Support\logs.

A new log is created daily at 11:59 PM as per the time zone configured in the system, and is stored in the 
logs directory with the date appended to the file extension. This enables you to identify the exact log file 
stored for a given date when alerts occur. For example, log files similar to the following can be seen:

• log-file.txt 20120226

• log-file.txt 20120227

• log-file.txt 20120228

Log files are purged from storage after 45 days.

To view the Windows Event Log, invoke the Event Viewer application and then expand Applications and 
Services Logs. The DellIntegratedSupport log file contains entries from the dashboard service. The 
dashboard logs messages here that correspond to the value of the Windows Registry key, 
WindowsEventLogLevel, or higher.

In the dashboard installation directory, you can view one log file per day. The current log file is named 
log-file.txt, and contains log messages that correspond to the following values (or higher) in the Windows 
Registry key LogFileLevel: FATAL, ERROR, WARN, INFO, and DEBUG, with special values of OFF and ALL. A 
registry value of ERROR results in logs messages of FATAL, and ERROR, since FATAL is a higher level than 
ERROR.

The LogFileLevel Windows Registry key can be located at HKEY_LOCAL_MACHINE\SOFTWARE
\Wow6432Node\Dell\Dell Integrated Support.

Accessing And Viewing The System Log Collection

When a support case is automatically generated by SupportAssist, data required to troubleshoot the issue 
is collected and sent to Dell technical support. The collected troubleshooting information is also 
compressed and stored on your OpenManage Essentials server at C:\Program Files (x86)\Dell\Dell 
Integrated Support\reports.

The filename includes the device’s IP address, Dell service tag, and the date/time when the file was 
created. For example:

• DSET_Report_for[192.168.1.254_SvcTag_AL12G26_2012-03-07T132648].zip

• Periodic_DSET_Report_for[192.168.1.254_SvcTag_AL12G26_2012-03-07T132648].zip
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• Lasso_Report_for[10.94.216.76_SvcTag_897672S_2012-08-21T094147].zip.gpg (without PII)

• Lasso_Report_for[10.94.216.76_SvcTag_897672S_2012-08-21T094147].xml.gpg (with PII)

The report file is encrypted with the password, dell (all lowercase). The report information can then be 
viewed by opening the dsetreport.hta file in your web browser.

NOTE: You should open the reports only when asked to do so by Dell technical support. Your 
report will not be reviewed unless you have an open support case.

Viewing SupportAssist Product Information

The About window displays the SupportAssist product version, copyright information, and detailed 
SupportAssist feature descriptions.

To view general and detailed SupportAssist product information:

1. Move the mouse pointer over the Help link at the top-right corner of the SupportAssist dashboard, 
and then click About.

The About window is displayed, where you can view the general and detailed product information 
and also the copyright information.

2. Click Close to return to the SupportAssist dashboard.

Viewing Support Information

The Help window displays SupportAssist product version and copyright information, and provides access 
to Dell Technical Support and Dell OpenManage Essentials information.

To view the support information for SupportAssist:

1. Move the mouse pointer over the Help link at the top-right corner of the SupportAssist dashboard, 
and then click Help.

The Help window is displayed.

2. In the Help window :

– Read the General product and copyright information.

– Click the links under Dell SupportAssist Additional Information & Updates to view:

* Dell Technical Support launch points, community forums, blogs, and much more

* Dell product manuals for hardware and software products

– Click the link under Dell OpenManage Essentials (OME) Additional Information & Updates to 
view Dell OpenManage Essentials Frequently Asked Questions, updates, videos, and so on.

3. Click Close to return to the SupportAssist dashboard.

Accessing The Context-Sensitive Help

The context-sensitive help provides information about features and tasks that are applicable to the 
current view on the dashboard. Once you invoke the context-sensitive help, you can navigate or search 
through the entire SupportAssist help system.

To access the context-sensitive help, click the  icon that appears in the dashboard. The context-
sensitive help is displayed in a new browser window.
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4
Troubleshooting
The following sections describe procedures you can use to troubleshoot Dell SupportAssist issues

Installing SupportAssist

SupportAssist installation requires elevated Microsoft User Authentication (UAC) privileges, and may fail if 
you attempt to install by double-clicking on the installer executable. If this occurs, install SupportAssist as 
follows:

1. Right-click the installer executable.

2. Select Run as administrator.

NOTE: SupportAssist installation requires that you allow Dell to save certain Personally 
Identifiable Information (PII) such as your contact information and local administrator 
credentials, and so on. SupportAssist installation cannot proceed unless you allow Dell to save 
your PII.

Registration Failure

After the installation of SupportAssist application on the management server, the SupportAssist 
application registers with the SupportAssist server hosted by Dell. If the registration is successful:

• A registration confirmation email is sent to your primary contact.

• The Client ID value is displayed in the SupportAssist Help → About window.

Registration failure occurs if the SupportAssist application has problems communicating with the 
SupportAssist server hosted by Dell. To resolve the communication problems, see Ensuring Successful 
Communication Between The SupportAssist Application And The SupportAssist Server.

Launching SupportAssist

If you see a Problem starting the Dell SupportAssist Service error upon launching 

SupportAssist:

• There may be a Microsoft Windows registry configuration problem with the SupportAssist Windows 
service. To resolve this issue, uninstall and then reinstall SupportAssist.

• The SupportAssist dashboard requires some DLLs that are installed in OpenManage Essentials. The 
SupportAssist installer checks that OpenManage Essentials is installed, and then checks the 
OpenManage Essentials version. If the DLLs are manually removed, the following error appears during 
installation:

Error 1920. Service Dell SupportAssist Service (PhomePluginWindowsService) 
failed to start.
If this occurs:
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– Verify that you have sufficient privileges to start system services.

– Check the log-file.txt file in the logs directory (typically, C:\Program Files (x86)\Dell\Dell Integrated 
Support\logs in 64-bit operating systems and at C:\Program Files\Dell\Dell Integrated Support
\logs in 32-bit operating systems) to see which component failed to load.

Services

• The SupportAssist application installed on the management server may not initially connect to the 
SupportAssist server hosted by Dell if your network requires passing web browser traffic through a 
proxy server. If this occurs:

– A dialog box may be displayed prompting you to configure your proxy settings. Provide the 
information required in the appropriate fields to connect to the SupportAssist server through your 
proxy server.

– Configure the proxy server settings in SupportAssist. See Configuring Proxy Server Settings.

– After configuring the proxy server settings, verify if the SupportAssist application can connect to 
the SupportAssist server through the proxy server by performing the connectivity test. See Testing 
SupportAssist Connectivity.

• If the SupportAssist dashboard application does not seem to connect to the SupportAssist server or 
behave appropriately, ensure that the SupportAssist Windows service is running:

1. Click Start → Run.

The Run dialog box is displayed.

2. Type services.msc, and then click OK.

The Services Microsoft Management Console (MMC) is displayed.

3. Check if the Dell SupportAssist Service displays the status as Running.

4. If the service is not running, start the service by right-clicking Dell SupportAssist Service → Start.

5. If the service cannot or does not start, open the most recent log file (log-file.txt), and then search for 
text with a timestamp of when you tried to start the service. The log file may contain a message 
indicating any dashboard startup errors and a possible problem diagnosis.

6. To verify that the SupportAssist application can connect to the SupportAssist server hosted by Dell , 
perform the connectivity test. See Testing SupportAssist Connectivity.

– If the server is responding, a success message is displayed in the dashboard. If not, the server may 
be down. If this occurs, look through the log-file.txt file, typically located at C:\Program Files 
(x86)\Dell\Dell Integrated Support\logs to find details. If there are no discernible details in the log 
file, and the server is not reachable, contact Dell technical support.

– If communication is successful, but no data updates occur, the dashboard may be identifying 
itself with an ID that is unknown to the server. If this occurs, look through the log-file.txt log file, 
typically located in C:\Program Files (x86)\Dell\Dell Integrated Support\logs to find details. The 
log file may contain a message stating that the dashboard was not recognized. If the dashboard is 
not recognized by the SupportAssist server, uninstall and reinstall SupportAssist.

The SupportAssist dashboard registers as a new client, enabling the SupportAssist server to recognize 
it.
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Collection Failure

If you receive a SupportAssist email notification indicating a collection issue with a specific device and the 
Collection Status of the device displays Failed to Run:

1. Verify if the device is connected to the network.

2. Verify the credentials you have provided for the device. You must provide the Administrator 
credentials in the Settings → System Logs page. For more information, see Configuring The Default 
Device Type Credentials and Editing Device Credentials.

3. Verify if the DNS is configured with the host name of the device. If you do not have a DNS server in 
your environment, update the hosts file located at C:\Windows\System32\drivers\etc with the IP 
address and the corresponding host name.

Collection Failed To Upload

If you receive a SupportAssist email notification indicating an issue uploading the collection for a specific 
device and the Collections Status of the device displays Collection Failed to Upload:

1. Verify if the management server on which SupportAssist is installed is able to connect to the Internet.

2. If the management server on which SupportAssist is installed connects to the Internet through a 
proxy server, ensure that you configure the proxy settings in SupportAssist. For more information, see 
Configuring Proxy Server Settings.

3. Perform the connectivity test and make sure that the test is successful. For more information, see 
Testing SupportAssist Connectivity.

4. Verify if the SupportAssist application is able to communicate successfully with the SupportAssist 
server. See Ensuring Successful Communication Between The SupportAssist Application And The 
SupportAssist Server.

After resolving the issue, manually upload a new collection for the device to Dell. For more information, 
see Sending The System Logs Manually.

Security

• The Settings tab is inaccessible and the Connectivity Test link is disabled. On clicking Settings tab, a 
dialog box is displayed with the following message: Access Denied. You must be logged in 
as a member of the Dell OpenManage Essentials Administrators or Power Users 
group to access this content.

• The Edit Device Credentials and Send System Logs links remain disabled even after selecting a device 
in the Device Inventory.

If this occurs, ensure that you are logged on as a member of either the OpenManage Essentials 
Administrators or Power Users group.

Identifying SSL Connection Failure

SSL connection failure may occur if your system does not have the required certificate installed from the 
issuing root certificate authority, GTE CyberTrust Global Root. All Dell certificates are issued from this 
certificate authority.
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To verify if the certificate is installed in Internet Explorer:

1. Click Tools → Internet Options.

The Internet Options dialog box is displayed.

2. Click the Content tab, and then click Certificates.

The Certificates dialog box is displayed.

3. Click the Trusted Root Certification Authorities tab.

4. Scroll to verify if GTE CyberTrust Global Root is listed in the Issued To and Issued By columns.

If GTE CyberTrust Global Root is not listed, you must install the required certificates. See Exporting The 
Root Certificate and Installing The Root Certificate.

Exporting The Root Certificate

To export the root certificate:

1. In Internet Explorer, go to https://dell.com.

2. If the Certificate Error: Navigation Blocked page is displayed, click Continue to this website (not 
recommended).

3. At the Do you want to view only the webpage content that was delivered securely? prompt, click 
Yes.

4. On the address bar, click the Security Report icon .

5. Click View certificates.

The Certificate window is displayed.

6. Click Details.

7. Click Copy to File.

The Certificate Export Wizard is displayed.

8. Click Next.

9. In the Export File Format page, click Next.

10. In the File to Export page, click Browse.

The Save As window is displayed.

11. Navigate to the location you want to save the certificate file.

12. Type a file name and click Save.

13. In the Export File Format page, click Next.

14. Click Finish.

The status of the export is displayed.

15. Click OK.

Installing The Root Certificate

Before you begin, ensure that:

• You are logged in using the user account with which SupportAssist was installed.

• You have administrator privileges.

• The SupportAssist service is running.

• You have exported the certificate file. See Exporting The Root Certificate.
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To install the root certificate:

1. Click Start → Run.

The Run dialog box is displayed.

2. In the Open box, type mmc, and click OK.

The Console1 – [Console Root] window is displayed.

3. Click File → Add/Remove Snap-in.

The Add or Remove Snap-ins dialog box is displayed.

4. Under Available snap-ins, select Certificates, and click Add >.

The Certificates snap-in dialog box is displayed.

5. Ensure that My user account is selected, and then click Finish.

6. In the Add or Remove snap-ins dialog box, click Add >.

The Certificates snap-in dialog box is displayed.

7. Select Computer account and click Next.

The Select Computer dialog box is displayed.

8. Ensure that Local computer: (the computer this console is running on) is selected, and click Finish.

9. In the Add or Remove snap-ins dialog box, click OK.

10. Under the Console Root, click Certificates – Current User.

11. Right-click Trusted Root Certification Authorities → All Tasks → Import.

The Certificate Import Wizard is displayed.

12. Click Next.

The File to Import dialog box is displayed.

13. Browse to select the certificate file you exported, and click Next.

The Certificate Store information is displayed.

14. Click Next.

15. Click Finish.

16. Right-click Intermediate Certification Authorities → All Tasks → Import.

The Certificate Import Wizard is displayed.

17. Browse to select the certificate file you exported, and click Next.

The Certificate Store information is displayed.

18. Click Next.

19. Click Finish.

20. Under the Console Root, click Certificates (Local Computer).

21. Perform step 11 to step 19 to install the root certificate.

Service Contract

The Service Contract column on the Case List report, may display a warning icon or Unknown. See the 

following sections for more information about these messages.

Service Contract Warning

A warning icon may appear in the Service Contract column of some cases if the associated device is not 
covered under a Dell service contract or the service contract has expired.
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If any cases display a warning icon in the Service Contract column:

1. Move the pointer over the warning icon to display a tooltip.

2. Click the Dell Support link displayed in the tooltip to open the service contract information page.

You can obtain current service contract information for your Dell devices, obtain new service contracts, 
and so on.

Service Contract Type Is Unknown

The Service Contract column on Case List report displays unknown for all existing support cases.

This issue occurs when you upgrade SupportAssist. Once an alert is received from the device, the Service 
Contract column is updated with the appropriate service contract type.

Service Tag Warnings

On rare occasions some cases may display an invalid Dell service tag warning. If you presume that the 
warning is incorrect, you can use the Windows Management Instrumentation CLI command (wmic) to 
find the correct Dell service tags for Windows devices.

To resolve service tag warnings:

1. Identify the service tag for your device.

2. Contact Dell technical support. See Contacting Dell.
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5
Dell SupportAssist Interface
The top-right corner of the SupportAssist dashboard displays links that you can use to navigate the 
interface. The following table describes the links that are displayed.

Link Description

SupportAssist 
Community

Opens the SupportAssist User Group website in a new browser window.

Help Move the mouse pointer over the link to display a drop-down that provides the 
following options:

• Help — Opens the Help window that provides links to Dell technical support 
and product manuals.

• About — Opens the About window that provides information about the 
SupportAssist version, copyright information, and also notifies if a newer 
version of SupportAssist is avaialable.

User name Displays the user name of the currently logged in user. Move the mouse pointer 
over the user name link to display a drop-down that contains a link to the 
Connectivity Test page.

NOTE: The Connectivity Test link is enabled only if you are logged in as a 
member of the Dell OpenManage Essentials Administrators or Power Users 
group.

 Update 
Available

Displays in the SupportAssist header area in the following situations:

• If an error occurred during the update of SupportAssist.

• If the Settings → Preferences → Enable auto update option is not selected, 
and you cancel the SupportAssist Update notification that is displayed.

You can click the link to download and install the SupportAssist update.

NOTE: The Update Available link is displayed only if you are logged in as a 
member of the Dell OpenManage Essentials Administrators or Power Users 
group.

By default, the Cases tab is displayed when SupportAssist is launched. The Devices tab displays the 
supported OpenManage Essentials-discovered devices. The Settings tab enables you to configure 
SupportAssist.

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators or Power Users group.

Related Links

Case List

Device Inventory
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Case List

The Case List is the default SupportAssist dashboard view. You can filter the cases that are displayed by 

selecting an option from the Filter By drop-down box. The  icon enables you to refresh the cases that 
are displayed.

The following table describes the automatically-generated support case information for your supported 
Dell devices, as displayed in the Case List page.

Column Description

Case Status The current state of the support case. The status of a case may be:

• Open — Dell technical support has opened the submitted case.

• In Progress — The case is currently being worked by Dell technical support.

• Customer Deferred — Dell technical support has deferred the case at the 
customer’s request.

• Submitted — SupportAssist has submitted the case.

• No Case — No case exists for this device.

• Reopened — The case was previously closed, and has been reopened.

Case Number The numeric identifier assigned to the support case.

Case Title The case name, which identifies:

• Case generation method

• Device model

• Device operating system

• Alert ID, if available

• Alert description, if available

• Warranty status

• Resolution description

Collection Status The current support case progress status. The progress status may be:

• Installing Collection Tool — Installation or update of the collection tool is in 
progress.

• Collection Tool Installation Is Unsuccessful — Installation of the collection 
tool is unsuccessful.

• Collection Tool Is Not Available — The collection tool is either not installed or 
manually uninistalled.

• Case Access Error — SupportAssist cannot currently access the case 
information.

• Case Service Unavailable – Dell’s support case service is currently unavailable.

• Collection Tools Not Supported — This device does not support 
SupportAssist’s collection tools.

• Troubleshooting Opted Out — Customer has opted out of SupportAssist’s 
troubleshooting capabilities.

• Collection Scheduled — Collection tool is scheduled to be run on this device.

• In Progress — Collection tool has been invoked on this device.

• Failed to Run — Collection tool started, but failed to run on this device.

• Collection Uploaded — Collection information has been uploaded to Dell.
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Column Description

• Collection Failed to Upload — Collection information was not successfully 
uploaded to Dell.

Service Contract The Dell service contract level under which the device is covered. The service 
contract column may display:

• Unknown — SupportAssist cannot determine the service contract.

• Invalid Service Tag — The service tag of the device is invalid.

• No Service Contract — This device is not covered under a Dell service 
contract.

• Expired Service Contract — The service contract of the device has expired.

• Basic Support — This device is covered under a Dell Basic Hardware service 
contract.

• ProSupport — This device is covered under a Dell ProSupport service contract.

• ProSupport Plus — This device is covered under a Dell ProSupport Plus service 
contract.

Device Type Indicates the type of device as discovered by OpenManage Essentials:

• Storage — The device is a PowerVault MD Series or EqualLogic storage array, 
or EqualLogic FluidFS NAS appliance.

• Server — The device is a Dell PowerEdge server, PowerEdge VRTX, iDRAC7, or 
CMC device.

• Switch — The device is a Dell Force10 or Dell PowerConnect Ethernet switch.

Service Tag A unique, alphanumeric identifier that enables Dell to individually recognize each 
Dell device.

Date Opened The date and time when the support case was opened.

You can set the number of support cases displayed per page by using the Display Cases drop-down box. 
The navigation icons enable you to navigate the pages of the Case List.

Related Links
Dell SupportAssist Interface
Viewing The Case List
Sorting The Case List Data By Column Name
Filtering The Case List Data By Column Name And Keyword
Returning The Case List Data To The Default Sorting
Setting The Number Of Cases Displayed Per Page
Refreshing The Case List Or Device Inventory Display Data

Device Inventory

The Device Inventory displays the supported OpenManage Essentials-discovered devices. The Edit 
Device Credentials link allows you to edit the credentials of a selected device. The Send System Logs link 
allows you to collect the system logs from a selected device and uploads it to Dell. You can filter the 

devices that are displayed by selecting an option from the Filter By drop-down box. The  icon enables 
you to refresh the devices that are displayed.

The following table describes the automatically-generated inventory information for your supported Dell 
devices, as displayed in the Device Inventory page.
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Column Description

Device Type Indicates the type of device as discovered by OpenManage Essentials:

• Storage — The device is a PowerVault MD Series or EqualLogic storage array, 
or EqualLogic FluidFS NAS appliance.

• Server — The device is a Dell PowerEdge, PowerEdge VRTX, iDRAC7, or CMC 
device.

• Switch — The device is a Force10 or PowerConnect Ethernet switch.

Service Tag A unique, alphanumeric identifier that enables Dell to individually recognize each 
Dell device.

Device Name Indicates the NetBIOS name of the device as discovered by OpenManage 
Essentials.

Collection Status Indicates the status of the system log collection. The collection status may be:

• Installing Collection Tool — Installation or update of the collection tool is in 
progress.

• Collection Tool Installation Is Unsuccessful — Installation of the collection 
tool is unsuccessful.

• Collection Tool Is Not Available — The collection tool is either not installed or 
manually uninstalled.

• Case Access Error — SupportAssist cannot currently access the case 
information.

• Case Service Unavailable – Dell’s support case service is currently unavailable.

• Collection Tools Not Supported — This device does not support 
SupportAssist’s collection tools.

• Troubleshooting Opted Out — Customer has opted out of SupportAssist’s 
troubleshooting capabilities.

• Collection Scheduled — Collection tool is scheduled to be run on this device.

• In Progress — Collection tool has been invoked on this device.

• Failed to Run — Collection tool started, but failed to run on this device.

• Collection Uploaded — Collection information has been uploaded to Dell.

• Collection Failed to Upload — Collection information was not successfully 
uploaded to Dell.

You can set the number of devices displayed per page by using the Display Devices drop-down box. The 
navigation icons enable you to navigate the pages of the Device Inventory.

Related Links

Dell SupportAssist Interface

Viewing The Device Inventory

Editing Device Credentials

Sending The System Logs Manually

Resetting The Device-Specific Credentials To The Default Device Type Credentials

Sorting The Device Inventory Data By Column Name

Filtering The Device Inventory Data By Column Name And Keyword

Returning The Device Inventory Data To The Default Sorting

Setting The Number Of Devices Displayed Per Page

Refreshing The Case List Or Device Inventory Display Data
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Settings

The Settings tab enables you to configure SupportAssist. By default, the System Logs page is displayed 
when the Settings tab is opened. The Settings tab includes the following pages:

• System Logs

• Proxy Settings

• Preferences

• Contact Information

Related Links

System Logs

Proxy Settings

Preferences

Contact Information

System Logs

The System Logs page enables you to:

• Edit the credentials required to collect the system logs from supported devices

• Schedule system log collections

The following table provides information about the fields displayed under Edit Device Credentials.

Field Description

Device Type Select the device type. The available options are:

• Server

• Storage

• Switch

Credential Type Select the specific device or operating system for which you want to 
provide the credentials. The options displayed depend on the Device Type 
you have selected.

The available options for Server are:

• Windows

• Linux

• ESX/ESXi

• iDRAC7

• CMC

The available options for Storage are:

• EqualLogic

• MD Series

• NAS Appliance

The available options for Switch are:

• PowerConnect
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Field Description

• Force10

Username Enables you to view or edit the user name.

Password Enables you to view or edit the password in a masked format.

Enable Password

NOTE: The Enable 
Password field is 
displayed only when 
the Device Type 
selected is Switch.

Enables you to view or edit the enable password in a masked format.

Community String

NOTE: The 
Community String 
field is displayed only 
when the Device 
Type selected is 
Storage.

Enables you to view or edit the community string in a masked format.

Overwrite the device-
specific credentials with 
the Default Device Type 
Credentials for all devices 
belonging to the current 
Device Type and 
Credential Type 

Enables you to overwrite the device-specific credentials that you had 
previously configured for some devices, with the Default Device Type 
Credentials. Only devices (of the selected Device Type and Credential 
Type ) that you had configured with device-specific credentials are 
affected.

The following table provides information about the fields displayed under System Log Collection 
Schedule.

NOTE: The System Log Collection Schedule options are enabled only if the Enable system log 
collection scheduling option is selected in the Preferences page.

NOTE: If your devices are covered under the Dell ProSupport Plus service contract, when the 
Enable system log collection scheduling option is not selected, you will not receive some reporting 
information about your devices.

Field Description

Frequency Enables selecting the frequency at which system logs are collected. The 
available options are:

• None

• Weekly

• Monthly

Specify day and time Enables selecting the day and time when you want to collect the system 
logs.
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Field Description

If the Frequency is set to Weekly, the available options are: weeks (1 or 2), 
day of the week (sunday, monday, tuesday, wednesday, thursday, friday, 
and saturday), hour (in hh:mm format), and AM/PM.

If the Frequency is set to Monthly, the available options are: week of the 
month (first, second, third, fourth, and last), day of the week (sunday, 
monday, tuesday, wednesday, thursday, friday, and saturday), hour (in 
hh:mm format), AM/PM, and months (1 or 3).

Start Date Displays the date and time at which the system logs will be collected next.

Related Links

Settings

Configuring The Default Device Type Credentials

Scheduling The Periodic Collection Of System Logs

Overwriting The Device-Specific Credentials With The Default Device Type Credentials

Proxy Settings

The Proxy Settings page enables you to configure the proxy server settings. The following table provides 
information about the items displayed in the Proxy Settings page.

Field Description

Use proxy settings Select this option to enable configuring the 
proxy server settings.

Proxy Server Address or Name Enables you to view or edit the proxy server 
address or name.

Proxy Port Number Enables you to view or edit the proxy server port 
number.

Proxy requires authentication Select this option if the proxy server requires 
authentication.

Username Enables you to view or edit the proxy server user 
name.

Password Enables you to view or edit the proxy server 
password in a masked format.

Confirm Password Enables you to retype the password provided in 
the Password field in a masked format.

Related Links

Settings

Configuring Proxy Server Settings

Preferences

The Preferences page enables you to configure Auto Update, Email Settings, Support Collection, and 
Maintenance Mode. The following table provides information about the options displayed in the 
Preferences page.
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Field Description

Auto Update

Enable auto update Select this option to automatically download and 
install the latest SupportAssist and collection tool 
updates, when they are available. The download 
and installation of the updates occur in the 
background. A message will be displayed if 
problems occur during the update process.

NOTE: It is recommended that you select the 
Enable auto update option, to ensure that 
SupportAssist is up-to-date with the latest 
features and enhancements.

Email Settings

Receive email notification when a new support 
case is opened

Select this option to receive an email notification 
when a new support case is opened.

Preferred email Language Select the preferred language for email 
notifications.

Support Collection

Automatically start a log collection when a new 
support case is generated 

Select this option to automatically start a system 
log collection when a new support case is 
generated.

Enable system log collection scheduling Select this option to enable scheduling of the 
system log collection. To schedule the system log 
collection, configure the System Log Collection 
Schedule in the System Logs tab.

Send network identification information to Dell Select this option to allow sending network 
identification information to Dell.

Maintenance Mode

Temporarily suspend case generation activity 
(e.g., for purposes of downtime, external 
troubleshooting, etc.) 

Select this option to set SupportAssist in 
maintenance mode. While in maintenance mode, 
no new support cases are opened.

Related Links

Settings

Enabling Auto Update

Configuring Email Notification Settings

Enabling Or Disabling The Automatic Collection Of System Logs

Enabling Or Disabling The Scheduling Of System Log Collection

Filtering The System Log Collection

Setting SupportAssist To Maintenance Mode
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Contact Information

The Contact Information page enables you to view and edit the primary and secondary contact 
information. The following table provides information about the items displayed in the Contact 
Information page.

Field Description

Company Information Enables you to view or edit the company name.

Primary Select this option to view the primary contact 
information.

Secondary Select this option to view the secondary contact 
information.

First Name Enables you to view or edit the first name of the 
primary or secondary contact.

Last Name Enables you to view or edit the last name of the 
primary or secondary contact.

Phone Number Enables you to view or edit the phone number of 
the primary or secondary contact.

Alternate Phone Number Enables you to view or edit the alternate phone 
number of the primary or secondary contact.

Email Address Enables you to view or edit the email address of 
the primary or secondary contact.

Related Links

Settings

Viewing And Updating The Contact Information

Connectivity Test

The Connectivity Test page enables you to test the inbound and outbound connectivity status of 
SupportAssist, in order to ensure that you can receive the most current case and device updates. For 
example, you may want to check the connectivity status following a network outage, a router or firewall 
configuration, or change made to the email address of the primary user. When you perform the 
connectivity test, SupportAssist receives the connectivity test request, and sends a sample email with the 
connectivity status and a reminder to configure your devices for monitoring.
Related Links

Testing SupportAssist Connectivity
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6
Related Documents And Resources
Other Documents You May Need

In addition to this guide, you can access the following guides available at the Dell Support website:

• Dell OpenManage Essentials Version 1.3 User’s Guide

• Dell SupportAssist Version 1.3 For Dell OpenManage Essentials Support Matrix

• Dell SupportAssist Version 1.3 For Dell OpenManage Essentials Quick Start Guide

• Dell SupportAssist Version 1.3 For Dell OpenManage Essentials Release Notes

• Dell System E-Support Tool User’s Guide

• Dell Lasso User's Guide

Related Links

Accessing Documents From Dell Support Site

Contacting Dell

Accessing Documents From Dell Support Site

You can access the required documents in one of the following ways:

• From the following links:

– For all Systems Management documents — dell.com/softwaresecuritymanuals 

– For Enterprise Systems Management documents — dell.com/openmanagemanuals 

– For Remote Enterprise Systems Management documents — dell.com/esmmanuals 

– For Serviceability Tools documents — dell.com/serviceabilitytools

– For Client Systems Management documents — dell.com/OMConnectionsClient 

– For OpenManage Connections Enterprise Systems Management documents — dell.com/
OMConnectionsEnterpriseSystemsManagement

– For OpenManage Connections Client Systems Management documents — dell.com/
OMConnectionsClient 

• From Dell Support site as follows:

– Go to dell.com/support/manuals.

– In the Tell us about your Dell system section, under No, select Choose from a list of all Dell 
products and click Continue.

– In the Select your product type section, click Software and Security.

– In the Choose your Dell Software section, click the required link from the following:

* Client System Management

* Enterprise System Management

* Remote Enterprise System Management
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* Serviceability Tools

– To view the document, click the required product version.

• Using search engines as follows:

– Type the name and version of the document in the Search box.

Related Links

Related Documents And Resources

Contacting Dell

NOTE: If you do not have an active Internet connection, you can find contact information on your 
purchase invoice, packing slip, bill, or Dell product catalog.

Dell provides several online and telephone-based support and service options. Availability varies by 
country and product, and some services may not be available in your area. To contact Dell for sales, 
technical support, or customer service issues:

1. Visit dell.com/support

2. Select your support category.

3. Verify your country or region in the Choose a Country/Region drop-down menu at the top of page.

4. Select the appropriate service or support link based on your need.

Related Links

Related Documents And Resources
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